
The "Live Configs" is a Simple & Mighty tool made for live performers by live performers.

It is France's second most important export after Champagne.

1) Foreword about “live”
Many things to say about “computer-based live performances”: many point of views, many possible
setups, drawbacks, advantages, hardware constraints, etc.. This document just deals with one software
solution. It describes typical setup examples and step-by-step procedures to configure it.

Also, as the wording “live” is used for very different things, the scope of this tool / document can be
simply clarified:

• Sound engineers mixing a band (or something) live

• “Playback-based” software, like live step sequencers, etc..

• Using the computer as an FX processor, just like a pedal effect. Here we are: performing live
on stage !

• Using the computer as like an instrument that is played via a MIDI-Controller, such as a Master
Keyboard, a Wind Controller or a similar device. Here we are: performing live on stage !

Reliability? 

About software: a close version of this tool is used on tour and validated on Win 7 64-bit & Win XP 32-
bit (REAPER v3.73, see 8). 

About hardware: there are many issues one can face on stage (vibrations, voltage drops in outdoor
festivals, the drunk factor, etc..) but they are not addressed in this document. Well, just keep in mind the
golden rule:

“I must have a backup solution ready to go - even if totally degraded!”

Note: if you are interested in advanced solutions like automatic HW fail-over management, get in touch!
($)
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2) Live Configs!? What is it?
As said above, we are on stage! So we do not care about the computer keyboard, the mouse or
things like that. We just want to plug things, boot the computer and play the guitar (or keys or
both: it works the same for audio and MIDI).

We just  need  a  MIDI  controller  to  change  “configs”  while  playing: buttons,  a  fader,  a  knob,  an
expression pedal or +/- pedals.

“Changing  configs”  means  changing  sounds  and  effects  (VST/VSTi,  AU,  ..),  FX presets,  routings,
triggering actions, etc.... well, anything but in a smooth and glitch-free way.

The "Live Configs" tool is a REAPER extension plugin (it is not an audio/MIDI plugin - like VST -, it only
works within REAPER).

REAPER is a Digital Audio Workstation: http://www.reaper.fm/download.php (free evaluation download).

It is rock solid software. This document assumes you know REAPER already so if something is not
clear for you, please have a look on its excellent user manual: http://www.reaper.fm/userguide.php.

The “Live Configs” tool is part of the SWS/S&M extension plugin which is free as in beer and free as
in speech.

This document refers to the version v2.6.0 Build #0. The last/up-to-date version of the extension plugin
is available here: http://code.google.com/p/sws-extension/downloads/list.

Both REAPER and the SWS/S&M extension run on Windows XP/Vista/7 (32-bit and 64-bit), OSX 32-bit
(10.4-10.7), OSX 64-bit (10.5-10.7) and OSX PPC (10.4-10.5).

3) Setting up Live Configs for using Program Change
Buttons

Additional Tools

While there are a lot different setups Live Configs can be helpful with, one of the most obvious usage
case is “Changing configs” while playing. With hardware equipment of different brands, such setups are
called “sounds”, “performances”, … you name it: e. g. a keyboarder switching from playing a sampled
e-piano to playing a physical modeling flute to playing a virtual Moog. Guitar players switching different
effect  chains.  In  many  setups,  the  player's  equipment  features  a  lot  of  buttons  to  easily  allow  a
dedicated selection of such a “sound”. In most cases, these buttons send MIDI “Program Change”
messages, while other setups use continuous sliders or effect pedals.

Now the current version of “Live Configs” (v2.6.0) does not directly use “Program Change” messages to
“activate a row” (see below), which in many cases would be desirable here. Hence, we need to use
(two)  additional  tools  to  have  Live  Configs  activate  a  dedicated  row  when  a  “Program”  button  is
pressed. It seems rather complicated to need to route the MIDI messages to Live Configs through the
FX chain of a track, but in fact this allows to easily modify the MIDI stream e.g. to use multiple MIDI
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channels or MIDI devices to select lines in a single Live Configs table or to use certain values from the
same source to control different Config tables.

In fact we need to convert the “Program Change” Message into a “Controller Change” (“CC”) message.
This  can  easily  done  by  a  JSFX  plugin  (“JesuSonic”  EEL  script).  Here  the  script  PCtoCC
http://forum.cockos.com/attachment.php?attachmentid=16843&d=1355303217 is  provided  for  exactly
this purpose. As such a JSFX plugin is just a text file, we will provide an extended version of the script
mentioned above at the end of this document.

The less obvious part is to route (internally in Reaper) the MIDI data stream from the track's FX chain to
Live Configs.

To do all this, a MIDI Master track needs to be provided to hold the JSFX “PCtoCC“ in it's effect chain.
The MIDI setup of this track is done so that it receives the MIDI stream from the device that holds the
program change buttons. [… aktivieren ?!?!? …] We can test whether this is working by at the top
position in the effect chain loading the JSFX “Midi_Logger”, that nicely features a MIDI Monitor Window.

In this example, PCtoCC is configured: 

• CC Output Channel = 16

• Output CC# = 60

• Pass through source PC = NO

By this we will have no interference with CC messages sent to out VST plugin, and PC messages will
not reach the VSTs, so that all realtime configuring of the VSTs is done by LiveConfig. LiveConfig will
learn controller 60 on channel 16 by pressing a Program change button. 

Now the modified MIDI stream needs to be routed from this track back into the guts of Reaper, where
Live Controls is connected, so that it  can digest it.  Reaper itself does not provide this functionality,
hence we need to install a VST at the end of this track's effect chain, that here is fed with the MIDI
stream  coming  from  PCtoCC.  Such  a  VST  is  “MIDItoReaControlPath”,  also  provided  for  free
(http://forum.cockos.com/showthread.php?t=43741).  For  the  purpose  in  question  it  should  be
configured like this; 

• Input channel = 16

• Input message type = Control Change

• Route to standard MIDI path = Not matching 1&2

• Route to control path = Matching 1&2

Beware that when using the “MIDItoReaControlPath” VST, you need not to check the "Enable input for
control messages" box in the Reaper options for any MIDI Interface, while you need to do so, if you
don't use “MIDItoReaControlPath”, but hardware controllers that natively send CC messages. 

Basic Setup

“Monitor Input” should be activated for all Audio Tracks. This can be done by clicking the small triangle 
left of “in” in the track head.

The MIDI routing should be done in a way so that the all Audio Tracks receive the MIDI input from the 
MIDI Master Track and not directly from a MIDI Device. This can be accomplished using a MIDI Bus 
when  defining the Routing after clicking “I/O” in the track head and adding a new “receive” or “send”, or
more obvious but less flexible by defining nested tracks as described in “4”. 

Selecting an Input Track other than “None” will automatically set an audio and Midi routing from all 
tracks that are defined in the LiveConfigs Page to this Track and when selecting a line in this page the 
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routed stream will be unmuted, while the streams from all other tracks mentioned on the page  (but not 
the tracks themselves) get muted. When setting the Input track to “None” you need to manually take 
vare of any routing. 

[“Multiple Configs → Folder Track Muted all siblings disabled”] ???

When planing your track layout for live use, beware that only those tracks that are used anywhere in a 
LiveConfig table will be muted, when LiveConfig unmutes a single of them (see 4).

4) Typical setup example: simple, efficient

Here  is  an  example  we  will  detail: when  it  is  started,  REAPER
automatically loads our project file1 which contains an “input track” (i.e. an
armed track without  “Master/parent  send”)  and all  the FX we need on
tracks 20 to 23 (or more). The MIDI or audio input is simply routed from
the input track 17 to those tracks.

Simple, efficient: all tracks and routings that are part of the config2 are
muted except the active one! The main advantages of this solution are:
immediate  and  seamless  switching  between  configs  (no  disk  access
during switches: everything is already present in the project file, as well as
CPU savings (see 8).

Again, this is just an example: there are many possible setups!

Here is another example without any “input track” (nor routing): the track
is simply armed/unarmed when activated/deactivated.

1 Live Configs are saved in REAPER project file (.RPP). You just need to configure things once and 
use this project when starting REAPER, this can be automatic: see 8). 

2 Live Configs will only deal with those tracks that appear in the appropriate table. All other tracks of 
the project file will remain untouched and thus can be used for other matters (or in other Live 
Configs, i.e. several controllers or musicians on the same computer). With our example above, it 
means that tracks #1 to #16, #18, #19 as well as all other tracks > #24 can be used for other 
purposes. 
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We can also imagine some tracks being re-configured with FX chains or track templates files: less RAM
usage but longer switches due to disk access + effect instantiation time (might be interesting for large
sample-based effects though), or more complicated setups like a track containing everything and being
reconfigured by disabling all FXs but the active one, etc...

Of course, even if limited, there are solutions without Live Configs too!

For MIDI, you can simply route the input track to other tracks containing VSTis: nothing is muted but
one instrument is being played at a time thanks to distinct MIDI channels. You are obviously limited to
16 configs in this case and you can face “stuck notes” when switching instruments...

As you can see, the idea is to let you define the setup you want. The tool will  not mess with your
project. It is up to you to define tracks, routings, FXs, etc.. It is up to you to use an “input track”, or not. It
is up to you to automatically mute things, or not. Etc..

A final advice about setups: the simpler, the better ! 

5) Multiple Instruments to be playing in parallel
With a single Event, LiveConfig will activate just a single track, and deactivate all others it knows about,
but leave the state of those that do not appear in the LiveConfig Table. 

Multiple LiveConfig Tables can work on different sets of tracks, hence by use of e.g. three Configs,
three managed tracks can be activated by the tool. But you can't “learn” the same input CC controller
(and MIDI channel) to multiple Configs and so you would need to use JSFX programming or other
means to generate two CC events with a single button click on the Master Keyboard to make use of this
feature for a single sound. 

Another way to activate multiple instruments in parallel is to place them in a single track and set the
track-internal audio routing (aka Pin-Connection) appropriately. 
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standard stereo track. (You can route multiple output
pins to an input pin of a VST, but just “connecting”
two outputs is not possible: only one of them will be
used.)



6) Live Config Tables

Columns:

1. CC value that will activate the row’s config, see 7). 
Double-clicking a cell in this column will activate the 
related config (useful to test things). The last activated 
config is tagged with the character * (e.g. row #006 
above). This column is not editable.

2. User comment. Double-click to edit it.

3. Track (optional). All tracks of the current project are 
available in the cell’s context menu.

4. Track template file (optional). A target track must be 
defined in column 2 then a file can be chosen via the 
context menu or by double-clicking a cell.

5. FX Chain file (optional). A target track must be defined in 
column 2 then a file can be chosen via the context menu 
or by double-clicking a cell.

6. FX user presets (optional): user presets defined in .rpl 
files (as opposed to patch/bank .fxp/.fxb files) so that it 
works for all FX types, not only for VST plugins. A track 
with target FX(s) must be defined in column 3, all its FXs 
and user presets are then listed in the cell’s context menu.
This feature/column is not yet available on OSX.

7. Action or macro that will be performed when activating the
row’s config (optional). On Windows OS, a command 
“Learn from Actions window” is available in the context 
menu. You can also double-click a cell to enter a 
“Command Id” or a “Custom Id”, see next page.

8. Action or macro that will be performed when deactivating 
the row’s config (optional). Also see column 7’s 
comments.

Defining configs is quite straight forward: everything is 
done through the context menu (which is “cell-dependent”).

A. Displayed config number
Up to 8[?]config tables can be used simultaneously but 
only one can be displayed at a time in the “Live Configs” 
window.

B. Enables/disables the current config. Learned MIDI CC 
messages are ignored when disabled. There are actions 
to toggle the current config too, see comment for 
column 7)

C. Input track (optional), see 4)

D. Delay imposed before enable/disable tracks after a mes-
sage had been received. This is important if a continuous 
controller (“effect” pedal or slider) is used as source.

E. [?]



Configs: step-by-step example

Ok, let’s configure something like the row “002” shown in the previous page:

This config will activate the track 21 “DistoAmp” which contains 2 FXs. We will also set presets for both
FXs and actions to unbypass the 2nd FX when the config is activated and another one to bypass it
when the config is deactivated (in other words, the 2nd FX is only used for that config row 002).

• Right-click the cell at row 002 / column “Track
→ a context menu proposing all tracks found in the project is displayed

• Choose a track
→ the cell is updated with the chosen track

Most of the time, this is enough (with the option “mute all  but active track”) but we also select FX
presets here...

• Right-click the cell at row 002 / column “FX user preset”
→ a context menu proposing all FXs found in the track you have chosen above is displayed
→ and, for each FX, a submenu proposes all available user presets

Note: the popup will have grayed items if there is a problem. For example “No FX” or grayed FX name if
no user presets are defined for it (load/make a RPL file first!)

• Choose a preset
→ the cell is updated with the chosen user preset

We repeat the preset selection for the 2nd FX...

Activate/deactivate actions example now: 2 ways you can do it depending on your OS...

• On OSX or Windows OS:
• Double-click the cell at row 002 / column “Activate action”
• Enter the “Command id” or the “Custom id” you want

• On Windows OS:
• Open the “Actions” window and select the action you want
• Right-click the cell at row 002 / column “Activate action”

→ a context menu is displayed
• Choose “Learn from Actions windows”

→ the cell is updated with the learned “Command id” or “Custom id”

Command id? Custom id!? What is it?

They are action identifiers used in REAPER. You can find them in the “Actions” window (if you cannot
see some of the columns shown here, right-click the table header to display them):

• “Custom ids” for macros and extension actions (like SWS/S&M ones)
• “Command ids” must be used for native actions
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7) MIDI Controller & Learn
Configs are smoothly activated thanks to a MIDI controller (a knob, a fader, an expression pedal, etc..).
The important thing is that only the last "stable" MIDI message is processed.  In other words, a
config will be activated only when you have finished tweaking the knob/pedal (and not while you are
tweaking it)3. At the moment, only controllers with absolute MIDI Control Change (CC) messages are
supported4. Fortunately, this is the one of main type of controllers.

Unlike REAPER’s macros5, the tool uses data values of CC messages. Example: say you have learned
the live config #1 with CC#4 (on a certain MIDI channel) → CC#4 value 10 can trigger one config (say a
FX preset), CC#4 value 11 can trigger another config (say loading a FX Chain), CC#4 value 12 can
trigger a third config (say performing a custom macro), etc..

Learn: step-by-step procedure

OK, we want to learn (i.e. “attach to a MIDI controller”) the live config #1:

• Open the Actions window, select the section “S&M Extension” (and not the “Main” one!)

• Select the action SWS/S&M: Apply live Config#1 (MIDI/OSC only)”

• Click on “Add”
→ a window “Keyboard or MIDI input” is opened

3 If using buttons or switches rather than continous controlles it makes sense to set the “Smoothing” 
to the minimum value.

4 Alternatively, you can also use two Note-On MIDI messages and learn the following actions of the 
“Main” section: “SWS/S&M: Live Config #n – Next” and “SWS/S&M: Live Config #n – Previous” 
(only the last "stable" config will be activated too).

5 You cannot use such CC values in macros. With the above example, the same macro is triggered 
whatever is the value of the CC#4 message.
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• Move your controller
→ the learned CC# appears

• Click OK
→ Done

8) Important recommendations
• REAPER > Options > Preferences > Audio > Close audio device *...+: all disabled

→ We want to use the audio engine whatever happens

• REAPER > Options > Preferences > Audio > Buffering > Allow live FX multi processing: enabled
+ set the proper number of CPUs

• REAPER > Options > Preferences > Audio > Playback > Run FX when stopped: enabled

• REAPER > Options > Preferences > Audio > Do not process muted tracks: enabled
→ CPU savings when the Live Configs’ option “mute all but active track” is enabled

• REAPER > General > Maximum undo memory use: 0 (i.e. undo disabled)
→ When you use a “headless” system without PC-keybopard, mouse and monitor, you will want
to shut it down just by hitting the power on/off pushbotton, making the OS close gracefully. If the
above setting is 0, Reaper will  not ask you to save your changes and hence not wait for user
input.

• REAPER > Main menu > Extensions > SWS Options: disable everything there

• Audio/MIDI plugins: if you face some issues, contact the author for a bug fix. No fix => 
quarantine ! (I personally do not advice bridging buggy plugins: some features of the Live 
Configs like preset switching will not be supported).

• Rather obviously you will want to stretch the area for the thread Controls to the right and 
squeeze the height of the threads to see a greater number of threads on the screen.

• If you intend to use many Sample instruments as VSTis, you might need to provide a decent 
amount of RAM

• If you intend to use combinations of high level effects as VSTs, you might need to have a 
reasonably fast multi core CPU. 

Some  of  these  options  are  not  really  compatible  with  song  edition,  you  can  start  REAPER  with
dedicated live settings (i.e. a “live edition” of the REAPER.ini file) thanks to a command line like:
reaper cfgfile ReaperLive.ini myLiveConfigs.rpp 6

6 of course, you make a .BAT file and move it in the “Startup” directory: the PC will boot with your live 
settings and the correct project file. Or in Windows use an appropriately crafted “link” in “Startup”.
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9) Backup
It's a good idea to backup the files that define your life config:

• The Reaper project file *.RPP contains most of the information
• S&M.ini [wirklich die LifeConfig Daten]
• *.rpl files [?]

10) Other tools for live performers
It  can be useful  to  switch between project  tabs  or  to  load projects  sequentially:  the “S&M Project
loader/selecter” tool and actions can interest you, details here:
http://forum.cockos.com/showpost.php?p=831103&postcount=655.

Those actions of the “Main” section can be useful too:

• SWS/S&M: Toggle Live Config #n enable

• SWS/S&M: Live Config #n – Next

• SWS/S&M: Live Config #n - Previous

A VST REAPER extension “MIDItoReaControlPath” can help too, see:
http://forum.cockos.com/showthread.php?t=43741.

It routes MIDI messages from the MIDI path within a track to the control path (i.e. automation/learn
within Reaper and Reaper Extensions) so it allows you preprocessing your controller MIDI messages
(typical example: triggering 2 different live configs but with a single controller or using other MIDI data
messages but CC values to select a Config row).

11) Some consideration on some special plugins
Native Instruments Kontakt

This  sophisticated  Sample  Player  features  it's  own  internal  patch  management  called  “Instrument
Banks”. 

If you straight forwardly define Kontakt instrument Patches, save them, and call them from LiveConfigs
using Reapers “preset” store and load feature, this will  cause a very long delay when activating a
Kontakt instrument, as the samples are purged and re-loaded at that point. So it's a good idea to make
use of a Kontakt “Instrument bank”, instead. If in Kontakt, an instrument bank is loaded, all samples
necessary for all patches in that bank get loaded (in fact just “pre-loaded”, as Kontakt is able to stream
the rest of the data directly from disk).  So we use an instance of Kontakt in a track and define an
instrument bank with all Kontakt instrument patches we want to use, and which we already configured
and saved before using Kontakt with just a single instrument. 

We then save this “Instruemnt Banks” setup in the Reaper project file. Now when starting the Reaper
“live” project,  Kontakt will only at that point in time take rather long to pre-load all appropriate samples.

Of course it's possible to load multiple such instrument banks in parallel the same instance of Kontakt,
so that multiple Kontakt instruments can be played at the same time. Remember, that when selecting
an empty slot in an instrument bank no sound will be generated by same, but only by other banks that
might listen to the same MIDI channel. 

To activate one of  the patches of  an instrument  bank,  Kontakt  needs to  be sent  a  MIDI  Program
Change message. Hence we need to create a Program Change MIDI message whenever LiveConfigs
activates a new “row”. This can be done in several ways. The way described here uses the same
mechanism that would be used when imposing a completely new configuration onto Kontakt. 

We just use a very simple JSFX script called “SliderToMidiPC” located before Kontakt in the effect chain
and  instead  of  directly  pushing  a  preset  onto  Kontakt,  we  have  LiveConfig  push  one  to  the
“SliderToMidiPC” that represents the patch number in the instrument bank loaded in Kontakt. Now, the
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JSFX will send appropriate MIDI PC messages whenever necessary (i. e. when it's “PC” slider is moved
by loading a new preset).

Over the fast patch change, there is an additional advantage in using this method. For each patch,
Kontakt now will remember any parameter change made in Live usage (e.g. by some hardware MIDI
controller assigned to a sound parameter), instead of resetting the value to the default with any patch
change. 

12) Contact, donate, feedback & thank yous
I am “Jeffos” on the REAPER user forums. You can contact me there (private message).

Donations are welcome, the PayPal link here: http://reaper.mj-s.com.

Bugs (if any) should be reported in the SWS issue tracker: 
http://code.google.com/p/sws-extension/issues/list.

For obvious reasons, I am highly committed to fix them!

You can post feedback and questions about the Live Configs tool in its dedicated discussion thread:
http://forum.cockos.com/showthread.php?t=96289.

Thank yous

I would like to acknowledge here the fantastic work of REAPER developers. I would also like to thank
the talented Tim Payne (SWS) for his incredible French skills, his technical support and for saving my
OSX butt a hundred times (at least).

Jeffos – February 2012
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